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1.1 Wilayah Kerja dalam SPSS 

PSS memiliki dua wilayah kerja, yakni Data View dan Variable View. Pada wilayah 

kerja Data View, data diinput. Sementara pada wilayah kerja Variable View, untuk 

mendefinisikan variabel, seperti nama variabel, jenis data, jumlah desimal, dan 

pemberian label terhadap data. 

 

Gambar 1.1 Dua Wilayah Kerja dalam SPSS 

S 

EKSPLORASI DATA DENGAN SPSS 
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1.2 Menginput Data dalam SPSS 

Misalkan diberikan data seperti pada Tabel 1.1. 

Tabel 1.1 Data Latihan 
Nama Jenis Kelamin Pendidikan Motivasi Kinerja 

A 1 1 65 65 

B 1 2 57 68 

C 1 3 55 56 

D 1 1 75 68 

E 1 2 78 76 

F 1 3 44 65 

G 2 1 56 55 

H 2 2 74 73 

I 2 3 55 67 

J 2 1 67 66 

K 2 2 44 65 

L 2 3 67 66 

 

1= Laki-Laki 1 = S1 

2= Perempuan 2 = S2 

 

3 = S3 

 

Berdasarkan data pada Tabel 1.1: 

 Terdapat empat variabel yakni jenis kelamin, pendidikan, motivasi dan kinerja. 

 Jenis kelamin dan pendidikan merupakan variabel kategori. Jenis kelamin memiliki dua 

kategori yakni laki-laki (diberi kode 1) dan Perempuan (diberi kode 2). Sementara 

pendidikan memiliki tiga kategori yakni S1 (diberi kode 1), S2 (diberi kode 2), da S3 (diberi 

kode 3). 

 Variabel motivasi dan kinerja merupakan variabel numerik atau rasio. 

 Sekarang kita akan menginput data pada Tabel 1.1 ke dalam SPSS. Pindahkan data pada 

Tabel 1.1 ke dalam SPSS seperti pada Gambar 1.2. Berdasarkan Gambar 1.2, data pada Tabel 

1.1 diinput pada bagian Data View. Selanjutnya variabel jenis kelamin, pendidikan, motivasi, 

dan kinerja didefinisikan pada wilayah Variable View (Gambar 1.3). Data yang telah diinput ke 

dalam SPSS terlihat pada Gambar 1.4. 
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Gambar 1.2 Data Diinput pada Wilayah Data View 

 

Gambar 1.3 Pendefinisian Variabel 
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Gambar 1.4 

1.3 Pemberian Label pada Variabel Kategori 

 Jenis kelamin dan pendidikan adalah variabel kategori. Misalkan akan diberi label 1 

untuk jenis kelamin laki-laki, dan label 2 untuk jenis kelamin perempuan. Masuk pada wilayah 

Variable View. Pilih Values pada baris jenis kelamin. Beri label 1 untuk laki-laki, dan label 2 

untuk Perempuan (Gambar 1.5). 

 

Gambar 1.5 Pemberian Label pada Variabel Jenis Kelamin 

 



 

 
5 APLIKASI METODE STATISTIKA KORELASI PEARSON & SPEARMAN  

Di Artikel Jurnal Nasional Bidang Psikologi Dengan SPSS 

 Selanjutnya kembali ke Data View. Tekan tombol Value Labels untuk mengubah value 

menjadi label, atau sebaliknya. Lakukan hal yang sama untuk variabel kategori pendidikan. 

 

 

Gambar 1.6 Menampilkan Value Label pada Variabel Kategori Jenis Kelamin 

1.4 Menyimpan Data dalam SPSS 

 Misalkan data pada Tabel 1.1 akan disimpan dalam SPSS. Pilih File => Save. Kemudian 

beri nama Data BAB I. Kemudian pilih Save (Gambar 1.7). 
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Gambar 1.7 Menyimpan Data dalam SPSS 

1.5 Distribusi Frekuensi (Univariat) 

 Misalkan kita ingin membuat tabel distribusi frekuensi berdasarkan variabel kategori 

Jenis kelamin dan pendidikan. Pilih Analyze => Descriptive Statistics => Frequencies 

(Gambar 1.8). Kemudian pindahkan variabel jenis kelamin dan pendidikan ke kotak sebelah 

kanan. Selanjutnya pilih OK. 
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Gambar 1.8  

 Berdasarkan Tabel 1.2, diketahui jumlah responden laki-laki sebanyak 6 (50%), 

sementara perempuan sebanyak 6 (50%). Jumlah responden dengan pendidikan S1 sebanyak 4 

(33.3%), S2 sebanyak 4 (33.3%) dan S3 sebanyak 4 (33.3%). 

Tabel 1.2 Output SPSS 

Jenis Kelamin 

  

Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid Laki-Laki 6 50.0 50.0 50.0 

Perempuan 6 50.0 50.0 100.0 

Total 12 100.0 100.0  
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Pendidikan 

  

Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid S1 4 33.3 33.3 33.3 

S2 4 33.3 33.3 66.7 

S3 4 33.3 33.3 100.0 

Total 12 100.0 100.0  

 

1.6 Menghitung Nilai Minimum, Maksimum, Rata-Rata dan Standar Deviasi (Univariat) 

 Misalkan kita ingin menghitung nilai minimum, maksimum, rata-rata dan standar deviasi 

dari variabel motivasi dan kinerja. Pilih Analyze => Decriptive Statistics => Descriptive 

(Gambar 1.9). Selanjutnya pindahkan variabel motivasi dan kinerja ke kotak sebelah kanan. 

Kemudian pilih OK.  

 

 

Gambar 1.9 
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Tabel 1.3 Output SPSS 

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Motivasi 12 44.00 78.00 61.4167 11.40541 

Kinerja 12 55.00 76.00 65.8333 5.89041 

Valid N (listwise) 12     

 

 Berdasarkan hasil pada Tabel 1.3, diketahui skor terendah motivasi adalah 44, sementara 

skor tertinggi 78. Rata-rata skor motivasi adalah 61.4167, dengan standar deviasi 11.40541. 

Skor terendah kinerja adalah 55, sementara skor tertinggi 76. Rata-rata skor kinerja adalah 

65.8333, dengan standar deviasi 5.89041. 

1.7 Menghitung Rata-Rata dan Standar Deviasi (Bivariat) 

 Misalkan kita ingin menghitung nilai rata-rata dan standar deviasi dari motivasi 

berdasarkan jenis kelamin. Pilih Analyze => Compare Means => One-Way ANOVA (Gambar 

1.10). Pindahkan variabel motivasi ke kotak Dependent List. Sementara variabel jenis kelamin 

ke kotak Factor. Kemudian pilih Options, sehingga muncul kotak dialog One-Way ANOVA: 

Options. Pilih Descriptive. Kemudian pilih Continue dan OK. 

 

 

Gambar 1.10
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Tabel 1.4 Output SPSS 

Descriptives 

 

N Mean Std. Deviation Std. Error 

95% Confidence Interval for 

Mean 

Minimum Maximum  Lower Bound Upper Bound 

Laki-Laki 6 62.3333 12.89444 5.26413 48.8014 75.8652 44.00 78.00 

Perempuan 6 60.5000 10.85818 4.43283 49.1050 71.8950 44.00 74.00 

Total 12 61.4167 11.40541 3.29246 54.1700 68.6633 44.00 78.00 

 Berdasarkan hasil pada Tabel 1.4, rata-rata motivasi laki-laki, yakni 62.3333, lebih tinggi 

dibandingkan perempuan,yakni 60.5000. 

1.8 Distribusi Frekuensi (Bivariat)  

 Misalkan kita ingin menyajikan tabel distribusi frekuensi berdasarkan dua variabel 

kategori, yakni jenis kelamin dan pendidikan. 

 

 

Gambar 1.11 

Pilih Analyze => Descriptive Statistics => Crosstabs (Gambar 1.11).  

 Pindahkan variabel jenis kelamin ke kotak Row(s). Sementara variabel pendidikan ke kotak 

Column(s). 
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 Kemudian pilih Cells. Pilih Observed pada Count dan pilih Row pada bagian Percentages. 

 Lalu pilih Continue dan OK. 

Tabel 1.5 Output SPSS 

Jenis Kelamin * Pendidikan Crosstabulation 

   Pendidikan 

Total    S1 S2 S3 

Jenis Kelamin Laki-Laki Count 2 2 2 6 

% within Jenis Kelamin 33.3% 33.3% 33.3% 100.0% 

Perempuan Count 2 2 2 6 

% within Jenis Kelamin 33.3% 33.3% 33.3% 100.0% 

Total Count 4 4 4 12 

% within Jenis Kelamin 33.3% 33.3% 33.3% 100.0% 

 

Berdasarkan Tabel 1.5: 

 Terdapat 6 laki-laki, 2 (33.3%) dengan pendidikan S1, 2 (33.3%) dengan pendidikan S2, 

dan 2 (33.3%) dengan pendidikan S3. 

 Terdapat 6 perempuan, 2 (33.3%) dengan pendidikan S1, 2 (33.3%) dengan pendidikan S2, 

dan 2 (33.3%) dengan pendidikan S3. 
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2.1 Sekilas Pengertian Korelasi Linear Pearson Berdasarkan Beberapa Buku 

erikut diberikan beberapa kutipan penjelasan mengenai korelasi linear Pearson dari 

beberapa buku. 

 

 John Maindonald dan W. John Braun (2010:67) dalam bukunya yang berjudul “Data 

Analysis and Graphics Using R, An Example-Based Approach 3rd Edition” menyatakan sebagai 

berikut. 

“The usual Pearson or product–moment correlation is a summary measure of linear 

relationship. Calculation of a correlation should always be accompanied by a check that the 

relevant scatterplot shows a linear relationship. Often the addition of a smooth trend line helps 

the assessment. Check also that the marginal distributions of the two variables are roughly 

normal, or at least not highly skew. If the relationship is monotonic, but is not linear and/or has 

asymmetric marginal distributions, it may be appropriate to use a Spearman rank correlation.”  

 Gareth James, Daniela Witten, Trevor Hastie dan Robert Tibshirani (2014:70) dalam 

bukunya yang berjudul “An Introduction to Statistical Learning with Applications in R” 

menyatakan sebagai berikut. 

“Recall that correlation, defined as: 

𝐶𝑜𝑟(𝑋, 𝑌) =
∑ (𝑥௜ − 𝑥̅)(𝑦௜ − 𝑦ത)௡

௜ୀଵ

ඥ∑ (𝑥௜ − 𝑥̅)௡
௜ୀଵ ඥ∑ (𝑦௜ − 𝑦ത)௡

௜ୀଵ
 [1.1] 

is also a measure of the linear relationship between 𝑋 and 𝑌. This suggests that we might be 

able to use 𝑟 = 𝐶𝑜𝑟(𝑋, 𝑌) instead of 𝑅ଶ in order to assess the fit of the linear model.” 

  

B 

SEKILAS TENTANG  
KORELASI PEARSON & SPEARMAN 
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 Peter Dalgaard (2008:120-122) dalam bukunya yang berjudul “Introductory Statistics with R, 

2nd Edition” menyatakan sebagai berikut. 

“A correlation coefficient is a symmetric, scale-invariant measure of association between two 

random variables. It ranges from −1 to +1, where the extremes indicate perfect correlation and 

0 means no correlation. The Pearson correlation is rooted in the two-dimensional normal 

distribution where the theoretical correlation describes the contour ellipses for the density. The 

empirical correlation coefficient is: 

𝐶𝑜𝑟(𝑋, 𝑌) =
∑ (𝑥௜ − 𝑥̅)(𝑦௜ − 𝑦ത) 

 

ඥ∑(𝑥௜ − 𝑥̅)ଶ  ∑(𝑦௜ − 𝑦ത)ଶ
 [1.2] 

 

It can be shown that |𝑟| will be less than 1 unless there is a perfect linear relation between 𝑥௜ 

and 𝑦௜, and for that reason the Pearson correlation is sometimes called the “linear 

correlation”.” 

 Michael J. Crawley (2015:108) dalam bukunya yang berjudul “Statistics, An Introduction 

Using R, 2nd Edition” menyatakan sebagai berikut. 

“With two continuous variables, x and y, the question naturally arises as to whether their values 

are correlated with each other (remembering, of course, that correlation does not imply 

causation). Correlation is defined in terms of the variance of x, the variance of y, and the 

covariance of x and y (the way the two vary together; the way they co-vary) on the assumption 

that both variables are normally distributed. We have symbols already for the two variances, 𝑠௫
ଶ 

and 𝑠௬
ଶ. We denote the covariance of 𝑥 and 𝑦 by cov(x, y), after which the correlation coefficient 

r is defined as 

𝑟 =
𝑐𝑜𝑣(𝑥, 𝑦)

ඥ𝑠௫
ଶ𝑠௬

ଶ
 [1.3] 

 Sanders & Smidth (2000:522-524) dalam bukunya yang berjudul “Statistics, A First Course, 

6th Edition” menyatakan sebagai berikut. 

“In correlation analysis, the purpose is to measure the strength or closeness of the relationship 

between the variables. In other words, regression analysis asks, “What is the pattern of the 

existing relationship?” and correlation analysis asks, “How strong is the relationship described 

in the regression equation?” Although it is possible to be concerned only with regression 

analysis or only with an analysis of correlation, the two are typically considered together. 
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…As you’ll notice in Figure 12.1, the eight points form a path that can be approximated by a 

straight line. Thus, there appears to be a linear relationship between variables. And a high 

degree of relationship is indicated by the fact that the points are all close to this straight-line 

path. You’ll also notice there’s a positive (or direct) relationship between variables, that is, as 

aptitude test results increase, output also increases. Of course, it’s quite possible for variables 

to have a negative (or inverse) relationship (as the 𝑥 value increases, the 𝑦 value decreases).” 

2.2 Korelasi Linear Pearson 

Berdasarkan uraian pada Bagian 2.1, diperoleh informasi sebagai berikut: 

 Korelasi linear Pearson dapat diartikan suatu nilai yang mengukur seberapa erat hubungan 

linear antara dua variabel (linear relationship) dan dapat diketahui arah hubungannya 

(direction) (John Maindonald dan W. John Braun, 2010:67; Sanders dan Smidth, 

2000:524). 

 Korelasi linear Pearson sering juga disebut dengan Pearson product-moment correlation 

(John Maindonald dan W. John Braun, 2010:67). 

 Notasi korelasi linear Pearson untuk sampel adalah “𝑟”, sementara untuk populasi adalah 

“𝜌” (dibaca: rho) (Douglas C. Montgomery dan George C. Runger, 2014:459; Damodar N 

Gujarati, 2003:85; Prem S. Mann, 2013:611). 

 Nilai korelasi linear Pearson berkisar dari −1 sampai dengan +1 (Peter Dalgaard, 

2008:120-122; Andy Field, 2009:173). 

 Nilai korelasi linear Pearson yang semakin dekat dengan −1 atau +1 menandakan sebaran 

data dari dua variabel tersebut semakin linear. Dengan kata lain hubungan linear antara dua 

variabel tersebut semakin kuat (Peter Dalgaard, 2008:120-122; Andy Field, 2009:173). 

 Nilai korelasi linear Pearson yang bernilai −1 atau +1 menandakan sebaran data dari dua 

variabel tersebut linear sempurna. Dengan kata lain hubungan linear antara dua variabel 

tersebut sempurna (Peter Dalgaard, 2008:120-122; Andy Field, 2009:173). 

 Nilai korelasi linear Pearson yang bernilai mendekati 0 menandakan sebaran data dari dua 

variabel tersebut semakin tidak linear. Dengan kata lain hubungan linear antara dua variabel 

tersebut semakin lemah, mungkin saja terdapat hubungan lain yang bersifat nonlinear (Peter 

Dalgaard, 2008:120-122; Andy Field, 2009:173). 

 Skala data yang dipersyaratkan dalam penggunaan korelasi linear Pearson adalah 

continuous atau kontinu atau numerik (Michael J. Crawley, 2015:108). 
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 Nilai koefisien korelasi linear Pearson bersifat simetri, maksudnya nilai korelasi linear 

Pearson antara 𝑋 dan 𝑌 (𝑟௫௬) akan sama dengan nilai korelasi linear Pearson antara 𝑌 dan 𝑋 

൫𝑟௬௫൯ (Peter Dalgaard, 2008:120-122; Gujarati N Damodar, 2003:85). 

Pembahasan selanjutnya akan dijelaskan lebih detail mengenai pernyataan-pernyataan di atas. 

2.3 Contoh Kurva Linear dan Nonlinear 

Misalkan diberikan data seperti pada Tabel 2.1. 

Tabel 2.1 Contoh Data 

No 𝑿 𝒀𝟏 𝒀𝟐 𝒀𝟑 𝒀𝟒 𝒀𝟓 

1 -5 25 -125 2 0.038462 8 

2 -4 16 -64 3 0.058824 7 

3 -3 9 -27 4 0.1 6 

4 -2 4 -8 5 0.2 5 

5 -1 1 -1 6 0.5 4 

6 0 0 0 7 1 3 

7 1 1 1 8 0.5 2 

8 2 4 8 9 0.2 1 

9 3 9 27 10 0.1 0 

10 4 16 64 11 0.058824 -1 

 

Berdasarkan data pada Tabel 2.1: 

 Akan disajikan grafik sebaran data antara 𝑋 dan 𝑌ଵ, dengan 𝑋 menempati sumbu-x dan 𝑌ଵ 

menempati sumbu-y (Gambar 2.1).  

 Akan disajikan grafik sebaran data antara 𝑋 dan 𝑌ଶ, dengan 𝑋 menempati sumbu-x dan 𝑌ଶ 

menempati sumbu-y (Gambar 2.2).  

 Akan disajikan grafik sebaran data antara 𝑋 dan 𝑌ଷ, dengan 𝑋 menempati sumbu-x dan 𝑌ଷ 

menempati sumbu-y (Gambar 2.3).  

 Akan disajikan grafik sebaran data antara 𝑋 dan 𝑌ସ, dengan 𝑋 menempati sumbu-x dan 𝑌ସ 

menempati sumbu-y (Gambar 2.4).  

 Akan disajikan grafik sebaran data antara 𝑋 dan 𝑌ହ, dengan 𝑋 menempati sumbu-x dan 𝑌ସ 

menempati sumbu-y (Gambar 2.5).  
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Gambar 2.1 Grafik Sebaran Data antara 𝑋 dan 𝑌ଵ  

 
Gambar 2.2 Grafik Sebaran Data antara 𝑋 dan 𝑌ଶ  

 
Gambar 2.3 Grafik Sebaran Data antara 𝑋 dan 𝑌ଷ  

 
Gambar 2.4 Grafik Sebaran Data antara 𝑋 dan 𝑌ସ  

 
Gambar 2.5 Grafik Sebaran Data antara 𝑋 dan 𝑌ହ  

Berdasarkan grafik sebaran data di atas, diketahui: 

 Kurva pada Gambar 2.1, Gambar 2.2, dan Gambar 2.4 merupakan kurva nonlinear (titik-

titik tepat pada kurva nonlinear). 

 Sementara kurva pada Gambar 2.3 dan Gambar 2.5 merupakan kurva linear (titik-titik 

tepat pada kurva linear) (Sanders dan Smidth, 2000:524). 

2.4 Contoh Sebaran Data Linear Sempurna dan Cenderung Linear 

Misalkan diberikan data seperti pada Tabel 2.2. 

Tabel 2.2 Contoh Data 
𝒀 𝑿𝟏 𝑿𝟐 𝑿𝟑 

1 7.8 9 1 

2 6.5 8 7 
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𝒀 𝑿𝟏 𝑿𝟐 𝑿𝟑 

3 8.2 7 9 

4 7.5 6 2 

5 6.2 5 3 

6 8.4 4 5 

7 3.5 3 12 

8 3.3 2 2 

9 4.2 1 4 

10 2 0 4 

 

 Berdasarkan data pada Tabel 2.2, disajikan grafik sebaran data antara 𝑋ଵ dan 𝑌, 𝑋ଶ dan 

𝑌, 𝑋ଷ dan 𝑌 (Gambar 2.6). 

 

 

Gambar 2.6 Sebaran Data antara 𝑋ଵ, 𝑋ଶ, 𝑋ଷ terhadap 𝑌 

Berdasarkan grafik sebaran data pada Gambar 2.6, diketahui: 

 Sebaran data antara 𝑋ଵ dan 𝑌 cenderung linear. Titik-titik cenderung dekat dengan garis 

linear (nilai korelasi linear Pearson -0,81, mendekati -1). Dengan kata lain hubungan antara 

variabel 𝑋ଵ dan 𝑌 cenderung linear (Sanders dan Smidth, 2000:524). 

 Sebaran data antara 𝑋ଶ dan 𝑌 linear sempurna. Titik-titik tepat pada garis linear (nilai 

korelasi linear Pearson -1). Hubungan antara 𝑋ଶ dan 𝑌 bersifat linear sempurna. 

 Sebaran data antara 𝑋ଷ dan 𝑌 cenderung tidak linear. Titik-titik cukup jauh dari garis linear 

(nilai korelasi Pearson 0,016, cenderung dekat dengan 0, yang berarti sebaran data 

cenderung tidak linear). Hubungan antara variabel 𝑋ଷ dan 𝑌 cenderung tidak bersifat linear. 
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2.5 Sebaran Data dari Dua Variabel (Sebaran Data Cenderung Naik/Positif; 

Turun/Negatif; Linear Positif Sempurna; Linear Negatif Sempurna) 

Misalkan diberikan contoh data seperti pada Tabel 2.3. 

Tabel 2.3 Contoh Data 
𝑿𝟏 𝑿𝟐 𝑿𝟑 𝑿𝟒 𝑿𝟓 𝒀 

1 5.4 9 7.8 5 1 

2 4.2 8 6.5 4 2 

3 3.3 7 8.2 3 3 

4 3.5 6 7.5 2 4 

5 8.4 5 6.2 12 5 

6 6.2 4 8.4 2 6 

7 7.5 3 3.5 3 7 

8 8.2 2 3.3 4 8 

9 6.5 1 4.2 5 9 

10 7.8 0 2 6 10 

 

 

Gambar 2.7 Sebaran Data antara 𝑋ଵ, 𝑋ଶ, 𝑋ଷ, 𝑋ସ, 𝑋ହ terhadap 𝑌 

Berdasarkan sebaran data pada Gambar 2.7, diperoleh informasi sebagai berikut. 

 Sebaran data antara 𝑋ଵ dan 𝑌 linear sempurna (titik-titik tepat pada garis). 𝑋ଵ meningkat, 𝑌 

juga pasti meningkat. 𝑋ଵ dan 𝑌 berkorelasi positif sempurna (nilai korelasi linear Pearson 1) 

(Sanders dan Smidth, 2000:524).  
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 Sebaran data antara 𝑋ଶ dan 𝑌 cenderung naik atau positif. Terdapat kecenderungan 𝑋ଶ yang 

semakin meningkat, 𝑌 juga meningkat. 𝑋ଶ dan 𝑌 berkorelasi positif namun tidak sempurna 

(titik-titik tidak tepat di garis) (nilai korelasi linear Pearson 0,686) (Sanders dan Smidth, 

2000:524). 

 Sebaran data antara 𝑋ଷ dan 𝑌 linear sempurna (titik-titik tepat di garis). 𝑋ଷ meningkat, 𝑌 

pasti turun. 𝑋ଷ dan 𝑌 berkorelasi negatif sempurna (nilai korelasi linear Pearson -1) 

(Sanders dan Smidth, 2000:524).  

 Sebaran data antara 𝑋ସ dan 𝑌 cenderung turun atau negatif. Terdapat kecenderungan 𝑋ସ 

yang semakin meningkat, 𝑌 menurun. 𝑋ସ dan 𝑌 berkorelasi negatif namun tidak sempurna 

(titik-titik tidak tepat di garis) (nilai korelasi linear Pearson -0,81) (Sanders dan Smidth, 

2000:524). 

 Sebaran data antara 𝑋ହ dan 𝑌 cenderung tidak linear. Titik-titik cukup jauh dari garis linear 

(nilai korelasi Pearson 0,088, cenderung dekat dengan 0, yang berarti sebaran data 

cenderung tidak linear). Hubungan antara variabel 𝑋ହ dan 𝑌 cenderung tidak bersifat linear. 

2.6 Mengukur Keeratan Hubungan Linear antara Dua Variabel dengan Korelasi Linear 

Pearson  

Misalkan diberikan contoh data seperti pada Tabel 2.4. 

Tabel 2.4 Contoh Data 
No Kinerja Motivasi Stres Gaji Berat Badan 

1 75 71 45 74 55.34 

2 65 60 65 67 65.34 

3 72 78 55 70 45.45 

4 84 79 55 80 71.21 

5 74 69 54 74 54.45 

6 59 55 76 59 48.53 

7 83 80 37 80 76.45 

8 55 45 75 52 76.45 

9 65 78 68 67 56.43 

10 73 77 54 70 63.34 

 

Berdasarkan data pada Tabel 2.4, ingin diketahui: 

 Faktor manakah yang memiliki korelasi/hubungan linear paling erat terhadap kinerja? 

Apakah motivasi, stres, gaji atau berat badan?  
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 Gambar 2.8 disajikan sebaran data antara motivasi, stres, gaji dan berat badan terhadap 

kinerja. Sementara Gambar 2.9 merupakan nilai-nilai korelasinya (korelasi linear Pearson). 

 

Gambar 2.8 Sebaran Data antara Motivasi, Stres, Gaji dan Berat Badan terhadap Kinerja  

 

Gambar 2.9 Korelasi Linear Pearson antar Variabel  

 Berdasarkan grafik sebaran data Gambar 2.8 dan nilai korelasi linear Pearson Gambar 

2.9, diperoleh hasil sebagai berikut. 

 Korelasi atau hubungan linear paling kuat pertama adalah antara gaji dan kinerja, dengan 

nilai korelasi linear Pearson 0,976. Nilai korelasi bernilai positif, yakni 0,976, dapat 

diartikan terdapat kecenderungan, gaji yang semakin meningkat, kinerjanya juga 

meningkat. Hubungan yang dimaksud di sini adalah hubungan linear.  
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 Sementara korelasi atau hubungan terkuat kuat kedua adalah antara stres dan kinerja, 

dengan nilai korelasi linear Pearson -0,888. Nilai korelasi bernilai negatif, yakni -0,888, 

dapat diartikan terdapat kecenderungan, stres yang semakin meningkat, kinerjanya 

menurun. 

 Korelasi atau hubungan terkuat ketiga adalah antara motivasi dan kinerja, dengan nilai 

korelasi linear Pearson 0,824. Nilai korelasi bernilai positif, yakni 0,824, dapat diartikan 

terdapat kecenderungan, motivasi yang semakin meningkat, kinerjanya meningkat.  

 Dan yang terakhir adalah antara berat badan dan kinerja, dengan nilai korelasi linear 

Pearson 0,18. Nilai korelasi linear Pearson bernilai positif, yakni 0,18, dapat diartikan 

terdapat kecenderungan, berat badan yang semakin meningkat, kinerjanya meningkat. 

2.7 Ukuran Pengaruh (Size of an Effect)  

 Andy Field (2009:170) dalam bukunya yang berjudul “Discovering Statistics Using 

SPSS, 3rd Edition” menyatakan sebagai berikut: 

“We also saw in section 2.6.4 that because the correlation coefficient is a standardized measure 

of an observed effect, it is a commonly used measure of the size of an effect and that values of 

±.1 represent a small effect, ±.3 is a medium effect and ±.5 is a large effect (although I re-

emphasize my caveat that these canned effect sizes are no substitute for interpreting the effect 

size within the context of the research literature).” 

Berdasarkan uraian di atas: 

 Nilai korelasi linear Pearson ±0,1 menyatakan small effect (pengaruh lemah). 

 Nilai korelasi linear Pearson ±0,3 menyatakan medium effect (pengaruh sedang). 

 Nilai korelasi linear Pearson ±0,5 menyatakan large effect (pengaruh besar). 

 Pada Bagian 2.6, diketahui nilai korelasi linear Pearson antara gaji dan kinerja adalah 

0,976 > 0,5, yang berarti gaji dan kinerja berkorelasi kuat. Namun nilai korelasi Pearson antara 

berat badan dan kinerja adalah 0,18 (di antara -0,3 dan +0,3), yang berarti berat badan dan 

kinerja berkorelasi lemah.  

 Perhatikan bahwa aturan pengelompokkan korelasi lemah, sedang atau kuat di atas, 

bukan aturan yang mutlak, dalam beberapa literatur lain, aturan pengelompokkan korelasi bisa 

berbeda. Seperti pada: http://www.dummies.com/education/math/statistics/how-to- interpret-a-

correlation-coefficient-r/ dan https://www.slideshare.net/phannithrupp/guideline-for-

interpreting-correlation-coefficient.  

 

http://www.dummies.com/education/math/statistics/how-to-%20interpret-a-correlation-coefficient-r/
http://www.dummies.com/education/math/statistics/how-to-%20interpret-a-correlation-coefficient-r/
https://www.slideshare.net/phannithrupp/%20guideline-for-interpreting-correlation-coefficient
https://www.slideshare.net/phannithrupp/%20guideline-for-interpreting-correlation-coefficient
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2.8 Kapan Uji Asumsi Normalitas Perlu Diuji? Apa Akibatnya Jika Asumsi Normalitas 

Tidak Dipenuhi? Pada Kondisi Bagaimana Uji Asumsi Normalitas Dapat Diabaikan? 

Menggunakan Pendekatan Apakah Untuk Menguji Keakuratannya? 

 Uji asumsi normalitas tidak perlu dilakukan apabila hanya sampai pada perhitungan nilai 

korelasi linear Pearson. Mengapa demikian? Hal ini karena terpenuhinya atau tidak terpenuhi 

asumsi normalitas tidak akan mempengaruhi hasil dari nilai korelasi linear Pearson. Alan 

Agresti dan Barbara Finlay (2009:284) dalam bukunya yang berjudul “Statistical Methods for 

the Social Sciences, 4th Edition” menyatakan sebagai berikut: 

“The least squares line and 𝑟 and 𝑟ଶ are valid descriptive statisics no matter what the shape of 

the conditional distribution of y-values for each x-value.”  

 Asumi normalitas yang dimaksud adalah kedua sampel diasumsikan ditarik dari populasi 

yang berdistribusi normal. Andy Field (2009:178) dalam bukunya “Discovering Statistics Using 

SPSS, 3rd Edition” menyatakan sebagai berikut: 

“However, if you want to establish whether the correlation coefficient is significant, then more 

assumptions are required: for the test statistic to be valid the sampling distribution has to be 

normally distributed and as we saw in Chapter 5 we assume that it is if our sample data are 

normally distributed (or if we have a large sample). Although typically, to assume that the 

sampling distribution is normal, we would want both variables to be normally distributed.” 

 Jadi pada saat kapan uji asumsi normalitas perlu diuji? Jawabannya adalah pada saat 

ketika kita akan melakukan uji signifikansi korelasi linear Pearson. Mengapa demikian? Hal ini 

karena, terpenuhinya atau tidak terpenuhinya asumsi normalitas akan mempengaruhi distribusi 

sampling dari statistik korelasi linear Pearson. Jika asumsi normalitas dipenuhi, maka distribusi 

sampling dari statistik korelasi linear Pearson ini akan berdistribusi 𝑡, sehingga aturan distribusi 

𝑡 dapat digunakan. Jika asumsi normalitas tidak dipenuhi, maka distribusi sampling dari statistik 

korelasi linear Pearson akan semakin jauh dari distribusi 𝑡, sehingga kesimpulan yang diperoleh 

menjadi tidak akurat.  

 Pada kondisi bagaimana uji asumsi normalitas dapat diabaikan? Uji asumsi normalitas 

dapat diabaikan ketika jumlah sampel cukup besar. Mengapa demikian? Hal ini karena ketika 

ukuran sampel besar, berdasarkan perluasan dari Teorema Limit Sentral (extended Central 

Limit Theorem) menyatakan distribusi sampling dari statistik korelasi linear Pearson akan 

mendekati normal. Dan juga distribusi 𝑡 akan mendekati distribusi normal ketika derajat bebas 

dari distribusi 𝑡 semakin besar. Alan Agresti dan Barbara Finlay (2009:284) dalam bukunya 
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yang berjudul “Statistical Methods for the Social Sciences, 4th Edition” menyatakan sebagai 

berikut: 

“However, the statistical inferences in Section 9.5 also assume that the conditional distributions 

of y are (1) normal, with (2) identical standard deviation tau for each x-value. These 

assumptions are also not exactly satisfied in practice. For large samples, the normality 

assumption is relatively unimportant, because an extended Central Limit Theorem implies 

that sample slopes and correlations have approximately normal sampling distributions.” 

 Dalam konteks ini, kapan ukuran sampel dikatakan besar? Ukuran sampel dikatakan 

cukup besar ketika di atas 30. Murray R. Spiegel dan Larry J. Stephens (275-276) dalam 

bukunya yang berjudul “Statistics 4th Edition” menyatakan sebagai berikut: 

 “In previous chapters we often made use of the fact that for samples of size N > 30, called 

large samples, the sampling distributions of many statistics are approximately normal, the 

approximation becoming better with increasing N. For samples of size N < 30, called small 

samples, this approximation is not good and becomes worse with decreasing N, so that 

appropriate modifications must be made. A study of sampling distributions of statistics for small 

samples is called small sampling theory. However, a more suitable name would be exact 

sampling theory, since the results obtained hold for large as well as for small samples. In this 

chapter we study three important distributions: Student’s t distribution, the chi-square 

distribution, and the F distribution.  

For large values of 𝑣 or 𝑁 (certainly 𝑁 ≥ 30) the curves (2) closely approximately the 

standardized normal curve: 

𝑌 =
1

√2𝜋
𝑒ିቀଵ

ଶቁ௧మ
 

 Menggunakan pendekatan apakah untuk menguji keakuratannya terhadap perubahan 

asumsi normalitas? Salah satu pendekatan untuk menguji keakuratannya adalah dengan 

menggunakan pendekatan simulasi Monte Carlo.  

2.9 Korelasi Linear Pearson Digunakan untuk Pengujian Validitas 

 Dalam beberapa literatur, sering ditemui korelasi linear Pearson digunakan untuk 

pengujian validitas. Berikut kutipan isi dari beberapa buku mengenai korelasi linear Pearson 

digunakan untuk pengujian validitas. 
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 Sugiyono (2015:207-209) dalam bukunya yang berjudul “Metode Penelitian 

Manajemen” menyatakan sebagai berikut: “Setelah data ditabulasikan, maka pengujian validitas 

konstruksi dilakukan dengan analisis faktor, yaitu mengkorelasikan antar skor item instrumen 

dalam suatu faktor dan mengkorelasikan skor faktor dengan skor total.” 

 Seperti telah dikemukakan bahwa, analisis faktor dilakukan dengan cara 

mengkorelasikan jumlah skor faktor dengan skor total. Bila korelasi tiap faktor tersebut positif 

dan besarnya 0,3 ke atas maka faktor tersebut merupakan konstrak yang kuat. Jadi berdasarkan 

analisis faktor itu dapat disimpulkan bahwa instrumen tersebut memiliki validitas konstruksi 

yang baik. Dari hasil perhitungan diketahui nilai korelasi ke tujuh butir instrumen dengan skor 

total ditunjukkan pada tabel 5.9 berikut: 

 Berdasarkan tabel 5.9 berikut dapat diketahui, bahwa butir no 3 (faktor 1) tidak valid, 

karena korelasi butir tersebut dengan skor total hanya 0,22 (di bawah r kritis 0,3). Butir tersebut 

tidak selaras dengan butir yang lain.” 

 Yvonne Augustine dan Robert Kristaung (2013:70) dalam bukunya yang berjudul 

“Metode Penelitian Bisnis dan Akuntansi” menyatakan sebagai berikut: 

“Construct validity: validitas ini mengukur seberapa besar derajat tes mengukur konstruk yang 

dikehendaki untuk diukur.  

 Validitas konstruk merupakan hasil deduksi dari suatu teori yang kita bangun. Analisis 

konfirmatori−merupakan metode terbaru yang digunakan untuk menguji validitas dan 

reliabilitas instrumen pengumpulan data. Cara analisisnya dengan menghitung faktor loading 

yang serupa korelasi antara indikator dan varaibel laten.  

 Validitas ini bersifat “judgmental”, demikian pendapat Hermawan, (2003:43), di mana 

suatu indikator dipandang sahih sepanjang sesuai dengan telaah pustaka mengenai suatu 

konstruk yang diteliti. Nilai patokan untuk uji validitas adalah koefisien korelasi yang mendapat 

nilai lebih besar dari 0,3 (Sekaran, 2000).” 

 Sebagi contoh kasus, misalkan akan dilakukan pengujian validitas dari 5 indikator untuk 

variabel laten motivasi. Data disajikan pada tabel 2.5. 

Tabel 2.5 Data Jawaban 10 Responden untk 5 Indikator 

Responden 
Motivasi 

Total 
P1 P2 P3 P4 P5 

1 3 4 3 3 4 17 

2 4 4 4 4 3 19 

3 2 3 4 4 4 17 

4 2 3 5 3 2 15 

5 3 4 3 3 3 16 
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Responden 
Motivasi 

Total 
P1 P2 P3 P4 P5 

6 4 4 3 4 3 18 

7 4 5 4 4 4 21 

8 3 4 4 5 4 20 

9 3 4 5 4 3 19 

10 4 3 5 3 3 18 

 Berdasarkan data pada Tabel 2.5, selanjutnya akan dihitung nilai korelasi linear Pearson 

antara setiap indikator terhadap skor total. Hasil diperoleh pada Tabel 2.6. 

Tabel 2.6 Hasil Uji Validitas dengan Korelasi Linear Pearson 
Indikator R Hitung (Korelasi Linear Pearson) R Kritis Keterangan 

P1 0.617213 0.3 Valid 

P2 0.673575 0.3 Valid 

P3 0.074536 0.3 Tidak Valid 

P4 0.721336 0.3 Valid 

P5 0.541002 0.3 Valid 

 Berdasarkan hasil uji validitas pada Tabel 2.6, diketahui indikator P3 tidak valid 

dikarenakan nilai korelasi linear Pearson 0,074 < 0,3 (Sugiyono, 2015:207-209).  

2.10 Ketika Akan Melakukan Uji Signifikansi Koefisien Korelasi Pearson, Kapan Uji 

Asumsi Normalitas Harus Diuji? Adakah Metode Alternatif Selain dari Korelasi 

Linear Pearson, ketika Asumsi Normalitas Tidak Dipenuhi?  

 Berdasarkan uraian sebelumnya, uji asumsi normalitas harus diuji dan dipenuhi ketika 

akan melakukan uji signifikansi koefisien korelasi linear Pearson (Alan Agresti dan Barbara 

Finlay, 2009:284; Andy Field, 2009:178), yang mana ukuran sampel kecil, yakni < 30 (Murray 

R. Spiegel dan Larry J. Stephens, 2008:275-276). Jika asumsi normalitas tidak dipenuhi, maka 

dapat digunakan pendekatan alternatif, yakni pendekatan nonparametrik berupa korelasi 

Spearman. Peter Dalgaard (2008:123) dalam bukunya yang berjudul “Introductory Statistics 

with R, 2nd Edition” menyatakan sebagai berikut: 

“As with the one- and two-sample problems, you may be interested in nonparametric variants. 

These have the advantage of not depending on the normal distribution and, indeed, being 

invariant to monotone transformations of the coordinates. The main disadvantage is that its 

interpretation is not quite clear. A popular and simple choice is Spearman’s rank correlation 

coefficient ρ. This is obtained quite simply by replacing the observations by their rank and 



 

 
27 APLIKASI METODE STATISTIKA KORELASI PEARSON & SPEARMAN  

Di Artikel Jurnal Nasional Bidang Psikologi Dengan SPSS 

computing the correlation. Under the null hypothesis of independence between the two 

variables, the exact distribution of ρ can be calculated.” 
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3.1 Contoh Kasus dan Data 

ontoh kasus berikut diadopsi oleh penelitian yang dilakukan oleh Layli 

Mumbaasithoh, Fiya Ma’arifa Ulya, dan Kukuh Basuki Rahmat dengan judul artikel 

“Kontrol Diri dan Kecanduan Gadget pada Siswa Remaja” di Jurnal Penelitian 

Psikologi pada tahun 2021. Data untuk Latihan diberikan pada Tabel 3.1. 

Tabel 3.1 Data Latihan 
Responden Kontrol Diri Kecanduan Gadget 

1 67 87 

2 65 88 

3 66 67 

4 75 75 

5 89 45 

6 56 57 

7 65 85 

8 66 56 

9 56 76 

10 44 77 

11 56 56 

12 77 56 

13 56 85 

14 87 56 

15 88 57 

16 78 65 

17 66 66 

18 78 75 

19 99 66 

20 67 78 

21 55 80 

C 

CONTOH KASUS KORELASI PEARSON: 
HUBUNGAN KONTROL DIRI DAN 

KECANDUAN GADGET 
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Responden Kontrol Diri Kecanduan Gadget 

22 75 46 

23 77 75 

24 57 65 

25 86 57 

26 89 65 

27 65 75 

28 66 77 

29 56 75 

30 46 67 

 Berdasarkan pada data Tabel 3.1, akan digunakan uji korelasi Pearson dan Spearman 

untuk menguji apakah terdapat hubungan atau korelasi yang signifikan antara Kontrol Diri dan 

Kecanduan Gadget.  

3.2 Penyelesaian dengan SPSS  

3.2.1 Input Data ke dalam SPSS 

Data pada Tabel 3.1 diinput ke dalam SPSS seperti pada Gambar 3.1. 

 

Gambar 3.1 Input Data dalam SPSS 
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3.2.2 Statistik Deskriptif 

 Data pada Tabel 3.1 akan dihitung nilai minimum, maksimum, rata-rata dan standar 

deviasi. Pilih Analyze => Descriptive Statistics => Descriptives (Gambar 3.2). Pindahkan 

variabel Kontrol Diri dan Kecanduan Gadget ke kotak sebelah kanan. Kemudian pilih OK. 

Tabel 3.2 disajikan output dari statistik deskriptif. 

 

 

Gambar 3.2 Menu Descriptives 

Tabel 3.2 Output SPSS untuk Statistik Deskriptif 

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Kontrol Diri 30 44.00 99.00 69.1000 13.72978 

Kecanduan Gadget 30 45.00 88.00 68.5000 11.79641 

Valid N (listwise) 30     

Berdasarkan Tabel 3.2: 

 Diketahui nilai minimum Kontrol Diri adalah 44, sementara nilai maksimum Kontrol Diri 

adalah 99. Rata-rata Kontrol Diri adalah 69.1, dengan standar deviasi 13.72978. 
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 Diketahui nilai minimum Kecanduan Gadget adalah 45, sementara nilai maksimum 

Kencanduan Gadget adalah 88. Rata-rata Kecanduan Gadget adalah 68.5, dengan standar 

deviasi 11.79641. 

3.2.3 Analisis Arah Sebaran Data (Scatterplot) 

 Selanjutnya akan dilihat arah sebaran data antara Kontrol Diri dan Kecanduan Gadget. 

Pilih Graphs => Legacy Dialogs => Scatter/Dot (Gambar 3.3). Kemudian pilih Simple 

Scatter. 

  

 

Gambar 3.3 Menu Scatter/Dot 

 Pindahkan variabel Kontrol Diri ke dalam kotak X-Axis:, sementara Kecanduan Gadget 

pada kotak Y-Axis. Kemudian pilih OK. Gambar 3.4 disajikan tampilan sebaran data antara 

Kontrol Diri dan Kecanduan Gadget. Berdasarkan Gambar 3.4 terlihat bahwa arah sebaran data 

cenderung memiliki arah negatif. Hal ini juga terlihat dari kemiringan garis, dari kiri atas, ke 

kanan bawah. Dengan kata lain, semakin tinggi Kontrol Diri, maka semakin rendah Kecanduan 
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Gadget. Atau sebaliknya, semakin rendah Kontrol Diri, maka semakin tinggi Kecanduan 

Gadget. 

 

Gambar 3.4 Sebaran Data antara Kontrol Diri dan Kecanduan Gadget 

3.2.4 Korelasi Pearson dan Spearman 

 Selanjutnya akan digunakan uji korelasi Pearson dan Spearman untuk menguji apakah 

terdapat hubungan atau korelasi yang signifikan antara Kontrol Diri dan Kecanduan Gadget. 

Pilih Analyze => Correlation => Bivariate (Gambar 3.5). Pindahkan variabel Kontrol Diri dan 

Kecanduan Gadget ke kotak sebelah kanan. Kemudian pilih menu Pearson dan Spearman. Lalu 

pilih OK.  
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Gambar 3.5 Analisis Data Dalam SPSS 

Tabel 3.3 Output SPSS untuk Korelasi Pearson dan Spearman  

 

Correlations 

  
 Kontrol Diri 

Kecanduan 

Gadget 

Spearman's rho Kontrol Diri Correlation Coefficient 1.000 -.439* 

Sig. (2-tailed) . .015 

N 30 30 

Kecanduan Gadget Correlation Coefficient -.439* 1.000 

Correlations 

  
Kontrol Diri 

Kecanduan 

Gadget 

Kontrol Diri Pearson Correlation 1 -.416* 

Sig. (2-tailed)  .022 

N 30 30 

Kecanduan Gadget Pearson Correlation -.416* 1 

Sig. (2-tailed) .022  

N 30 30 

*. Correlation is significant at the 0.05 level (2-tailed). 
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Correlations 

  
 Kontrol Diri 

Kecanduan 

Gadget 

Sig. (2-tailed) .015 . 

N 30 30 

*. Correlation is significant at the 0.05 level (2-tailed). 

Berdasarkan hasil uji korelasi Pearson dan Spearman pada Tabel 3.3: 

 Diketahui nilai korelasi Pearson antara Kontrol Diri dan Kecanduan Gadget adalah -0.416, 

yang berarti, jika Kontrol Diri meningkat, Kecanduan Gadget menurun atau sebaliknya jika 

Kontrol Diri menurun, Kecanduan Gadget meningkat. Diketahui nilai Sig. (2-tailed) adalah 

0.022 < 0.05, maka disimpulkan terdapat korelasi yang signifikan antara Kontrol Diri dan 

Kecanduan Gadget. 

 Diketahui nilai korelasi Spearman antara Kontrol Diri dan Kecanduan Gadget adalah -

0.439, yang berarti, jika Kontrol Diri meningkat, Kecanduan Gadget menurun atau 

sebaliknya jika Kontrol Diri menurun, Kecanduan Gadget meningkat. Diketahui nilai Sig. 

(2-tailed) adalah 0.015 < 0.05, maka disimpulkan terdapat korelasi yang signifikan antara 

Kontrol Diri dan Kecanduan Gadget. 
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4.1 Contoh Kasus dan Data 

ontoh kasus berikut diadopsi oleh penelitian yang dilakukan oleh Muhammad Dzakir 

Amaniey, Farida Harahap dengan judul artikel “Hubungan Antara Bersyukur 

dengan Kesehatan Mental pada Mahasiswa” di Jurnal Acta Psychologia pada tahun 

2022. Data untuk Latihan diberikan pada Tabel 4.1. 

Tabel 4.1 Data Latihan 
Responden Bersyukur Kesehatan Mental 

1 75 70 

2 79 66 

3 61 59 

4 80 77 

5 79 80 

6 65 67 

7 85 85 

8 66 56 

9 69 55 

10 81 75 

11 56 56 

12 77 86 

13 62 50 

14 60 56 

15 63 57 

16 78 70 

17 63 61 

18 75 78 

19 71 62 

20 78 67 

21 50 60 

C 

CONTOH KASUS KORELASI PEARSON: 
HUBUNGAN ANTARA BERSYUKUR DENGAN 

KESEHATAN MENTAL PADA MAHASISWA 
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Responden Bersyukur Kesehatan Mental 

22 71 61 

23 68 74 

24 57 65 

25 56 57 

26 62 65 

27 70 60 

28 58 52 

29 55 61 

30 52 59 

31 55 53 

32 62 71 

33 58 64 

34 60 58 

35 67 60 

36 82 77 

37 54 61 

38 70 68 

39 66 70 

40 76 77 

41 70 65 

42 52 60 

43 81 82 

44 62 65 

45 74 78 

46 55 60 

47 63 67 

48 78 80 

49 58 58 

50 66 70 

 Berdasarkan pada data Tabel 4.1, akan digunakan uji korelasi Pearson dan Spearman 

untuk menguji apakah terdapat hubungan atau korelasi yang signifikan antara Bersyukur dan 

Kesehatan Mental. 

4.2 Penyelesaian dengan SPSS  

4.2.1 Input Data ke dalam SPSS 

Data pada Tabel 4.1 diinput ke dalam SPSS seperti pada Gambar 4.1. 
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Gambar 4.1 Input Data dalam SPSS 

4.2.2 Statistik Deskriptif 

 Data pada Tabel 4.1 akan dihitung nilai minimum, maksimum, rata-rata dan standar 

deviasi. Pilih Analyze => Descriptive Statistics => Descriptives (Gambar 4.2). Pindahkan 

variabel Bersyukur dan Kesehatan Mental ke kotak sebelah kanan. Kemudian pilih OK. Tabel 

4.2 disajikan output dari statistik deskriptif. 

  

Gambar 4.2 Menu Descriptives 
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 Tabel 4.2 Output SPSS untuk Statistik Deskriptif  

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Bersyukur 50 50.00 85.00 66.6200 9.46506 

Kesehatan Mental 50 50.00 86.00 65.8200 9.07270 

Valid N (listwise) 50     

Berdasarkan Tabel 4.2: 

 Diketahui nilai minimum Bersyukur adalah 50, sementara nilai maksimum Bersyukur 

adalah 85. Rata-rata Bersyukur adalah 66.62, dengan standar deviasi 9.46506. 

 Diketahui nilai minimum Kesehatan Mental adalah 50, sementara nilai maksimum 

Kencanduan Gadget adalah 88. Rata-rata Kecanduan Gadget adalah 86, dengan standar 

deviasi 9.07270. 

4.2.3 Analisis Arah Sebaran Data (Scatterplot) 

 Selanjutnya akan dilihat arah sebaran data antara Bersyukur dan Kesehatan Mental. Pilih 

Graphs => Legacy Dialogs => Scatter/Dot (Gambar 4.3). Kemudian pilih Simple Scatter. 

  

 

Gambar 4.3 Menu Scatter/Dot  
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 Pindahkan variabel Bersyukur ke dalam kotak X-Axis:, sementara Kesehatan Mental 

pada kotak Y-Axis. Kemudian pilih OK. Gambar 4.4 disajikan tampilan sebaran data antara 

Bersyukur dan Kesehatan Mental. Berdasarkan Gambar 4.4 terlihat bahwa arah sebaran data 

cenderung memiliki arah positif. Hal ini juga terlihat dari kemiringan garis, dari kiri bawah, ke 

kanan atas. Dengan kata lain, semakin tinggi Bersyukur maka semakin tinggi Kesehatan Mental. 

Atau sebaliknya, semakin rendah Bersyukur maka semakin rendah juga Kesehatan Mental. 

 

Gambar 4.4 Sebaran Data antara Bersyukur dan Kesehatan Mental 

4.2.4 Korelasi Pearson dan Spearman 

 Selanjutnya pilih Analyze => Correlation => Bivariate (Gambar 4.2). Pindahkan 

variabel Bersyukur dan Kesehatan Mental ke kotak sebelah kanan. Kemudian ceklis menu 

Pearson dan Spearman. Lalu pilih OK. 
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Gambar 4.2 Analisis Data dalam SPSS 

Tabel 4.2 Output Korelasi Pearson dan Spearman  

Correlations 

  
Bersyukur 

Kesehatan 

Mental 

Bersyukur Pearson Correlation 1 .758** 

Sig. (2-tailed)  .000 

N 50 50 

Kesehatan Mental Pearson Correlation .758** 1 

Sig. (2-tailed) .000  

N 50 50 

**. Correlation is significant at the 0.01 level (2-tailed). 
 

Correlations 

   
Bersyukur 

Kesehatan 

Mental 

Spearman's rho Bersyukur Correlation Coefficient 1.000 .723** 

Sig. (2-tailed) . .000 

N 50 50 

Kesehatan Mental Correlation Coefficient .723** 1.000 
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Correlations 

   
Bersyukur 

Kesehatan 

Mental 

Sig. (2-tailed) .000 . 

N 50 50 

**. Correlation is significant at the 0.01 level (2-tailed). 

Berdasarkan hasil uji korelasi Pearson dan Spearman pada Tabel 4.2: 

 Diketahui nilai korelasi Pearson antara Bersyukur dan Kesehatan Mental adalah 0.758, yang 

berarti, jika Bersyukur meningkat maka Kesehatan Mental juga akan meningkat. Sebaliknya 

jika Bersyukur menurun maka Kesehatan Mental juga menurun. Diketahui nilai Sig. (2-

tailed) adalah 0.000 < 0.05, maka disimpulkan terdapat korelasi yang signifikan antara 

Bersyukur dan Kesehatan Mental. 

 Diketahui nilai korelasi Spearman antara Bersyukur dan Kesehatan Mental adalah 0.723, 

yang berarti, jika Bersyukur meningkat maka Kesehatan Mental meningkat atau sebaliknya 

jika Bersyukur menurun, maka Kesehatan Mental juga menurun. Diketahui nilai Sig. (2-

tailed) adalah 0.000 < 0.05, maka disimpulkan terdapat korelasi yang signifikan antara 

Bersyukur dan Kesehatan Mental. 
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45 APLIKASI METODE STATISTIKA KORELASI PEARSON & SPEARMAN  

Di Artikel Jurnal Nasional Bidang Psikologi Dengan SPSS 

 

 

 

 

 

 

5.1 Contoh Kasus dan Data 

ontoh kasus berikut diadopsi oleh penelitian yang dilakukan oleh Ancilla Ghislaine 

Orsley dan Erni Julianti Simanjuntak dengan judul artikel “Hubungan antara 

Kecemburuan Romantis dengan Kepuasan Hubungan pada Emerging Adult 

yang Berpacaran” di Jurnal Psikologi Teori dan Terapan pada tahun 2023. Data untuk Latihan 

diberikan pada Tabel 5.1. 

Tabel 5.1 Data Latihan 
Responden Kecemburuan Romantis Kepuasan Hubungan 

1 80 45 

2 65 41 

3 50 88 

4 68 42 

5 79 51 

6 56 50 

7 63 50 

8 51 78 

9 50 47 

10 79 51 

11 68 42 

12 71 50 

13 66 66 

14 81 60 

15 60 40 

16 87 71 

17 60 49 

18 57 41 

19 71 40 

20 43 70 

C 

CONTOH KASUS KORELASI PEARSON: 
HUBUNGAN ANTARA KECEMBURUAN 

ROMANTIS DENGAN KEPUASAN HUBUNGAN 
PADA EMERGING ADULT YANG BERPACARAN 
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Responden Kecemburuan Romantis Kepuasan Hubungan 

21 83 55 

22 51 87 

23 70 51 

24 75 42 

25 77 40 

26 89 56 

27 50 80 

28 40 87 

29 56 86 

30 79 41 

31 85 42 

32 71 50 

33 78 42 

34 80 50 

35 45 75 

36 82 40 

37 45 80 

38 58 85 

39 42 79 

40 79 43 

 Berdasarkan pada data Tabel 5.1, akan digunakan uji korelasi Pearson dan Spearman 

untuk menguji apakah terdapat hubungan atau korelasi yang signifikan antara Kecemburuan 

Romantis dan Kepuasan Hubungan. 

5.2 Penyelesaian dengan SPSS  

5.2.1 Input Data ke dalam SPSS 

Data pada Tabel 5.1 diinput ke dalam SPSS seperti pada Gambar 5.1. 

5.2.2 Statistik Deskriptif 

 Data pada Tabel 5.1 akan dihitung nilai minimum, maksimum, rata-rata dan standar 

deviasi. Pilih Analyze => Descriptive Statistics => Descriptives (Gambar 5.2). Pindahkan 

Kecemburuan Romantis dan Kepuasan Hubungan ke kotak sebelah kanan. Kemudian pilih OK. 

Tabel 5.2 disajikan output dari statistik deskriptif. 
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Gambar 5.1 Input Data dalam SPSS 

 

Gambar 5.2 Menu Descriptives 

Tabel 5.2 Output SPSS untuk Statistik Deskriptif 

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Kecemburuan Romantis 40 40.00 89.00 66.0000 14.25231 
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Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Kepuasan Hubungan 40 40.00 88.00 57.0750 16.83919 

Valid N (listwise) 40     

Berdasarkan Tabel 5.2: 

 Diketahui nilai minimum Kecemburuan Romantis adalah 40, sementara nilai maksimum 

Kecemburuan Romantis adalah 89. Rata-rata Kecemburuan Romantis adalah 66, dengan 

standar deviasi 14.25231. 

 Diketahui nilai minimum Kepuasan Hubungan adalah 40, sementara nilai maksimum 

Kepuasan Hubungan adalah 88. Rata-rata Kepuasan Hubungan adalah 57.07, dengan 

standar deviasi 16.83919. 

5.2.3 Analisis Arah Sebaran Data (Scatterplot) 

 Selanjutnya akan dilihat arah sebaran data antara Kecemburuan Romantis dan Kepuasan 

Hubungan. Pilih Graphs => Legacy Dialogs => Scatter/Dot (Gambar 5.3). Kemudian pilih 

Simple Scatter. 

 Pindahkan variabel Kecemburuan Romantis ke dalam kotak X-Axis:, sementara 

Kepuasan Hubungan pada kotak Y-Axis. Kemudian pilih OK. Gambar 5.4 disajikan tampilan 

sebaran data Kecemburuan Romantis dan Kepuasan Hubungan. Berdasarkan Gambar 5.4 

terlihat bahwa arah sebaran data cenderung memiliki arah negatif. Hal ini juga terlihat dari 

kemiringan garis, dari kiri atas, ke kanan bawah. Dengan kata lain, semakin tinggi Kecemburuan 

Romantis, maka semakin rendah Kepuasan Hubungan. Atau sebaliknya, semakin rendah 

Kecemburuan Romantis, maka semakin tinggi Kepuasan Hubungan. 
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Gambar 5.3 Menu Scatter/Dot 

 

Gambar 5.4 Sebaran Data antara Kecemburuan Romantis dan Kepuasan Hubungan 

5.2.4 Korelasi Pearson dan Spearman 

 Selanjutnya pilih Analyze => Correlation => Bivariate (Gambar 5.2). Pindahkan 

variabel Kecemburuan Romantis dan Kepuasan Hubungan ke kotak sebelah kanan. Kemudian 

ceklis menu Pearson dan Spearman. Lalu pilih OK. 
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Gambar 5.2 Analisis Data dengan SPSS 

Tabel 5.2 Output Korelasi Pearson dan Spearman  

Correlations 

  Kecemburuan 

Romantis 

Kepuasan 

Hubungan 

Kecemburuan Romantis Pearson Correlation 1 -.628** 

Sig. (2-tailed)  .000 

N 40 40 

Kepuasan Hubungan Pearson Correlation -.628** 1 

Sig. (2-tailed) .000  

N 40 40 

**. Correlation is significant at the 0.01 level (2-tailed). 

 
Correlations 

   Kecemburuan 

Romantis 

Kepuasan 

Hubungan 

Spearman's rho Kecemburuan Romantis Correlation Coefficient 1.000 -.456** 

Sig. (2-tailed) . .003 

N 40 40 

Kepuasan Hubungan Correlation Coefficient -.456** 1.000 
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Correlations 

   Kecemburuan 

Romantis 

Kepuasan 

Hubungan 

Sig. (2-tailed) .003 . 

N 40 40 

**. Correlation is significant at the 0.01 level (2-tailed). 

Berdasarkan hasil uji korelasi Pearson dan Spearman pada Tabel 5.2: 

 Diketahui nilai korelasi Pearson antara Kecemburuan Romantis dan Kepuasan Hubungan 

adalah -0,628, yang berarti, jika Kecemburuan Romantis meningkat, maka Kepuasan 

Hubungan menurun atau sebaliknya jika Kecemburuan Romantis menurun, maka Kepuasan 

Hubungan meningkat. Diketahui nilai Sig. (2-tailed) adalah 0,000 < 0,05, maka disimpulkan 

terdapat korelasi yang signifikan antara Kecemburuan Romantis dan Kepuasan Hubungan. 

 Diketahui nilai korelasi Spearman antara Kecemburuan Romantis dan Kepuasan Hubungan 

adalah -0,456, yang berarti, jika Kecemburuan Romantis meningkat, maka Kepuasan 

Hubungan menurun atau sebaliknya jika Kecemburuan Romantis menurun, maka Kepuasan 

Hubungan meningkat. Diketahui nilai Sig. (2-tailed) adalah 0,003 < 0,05, maka disimpulkan 

terdapat korelasi yang signifikan antara Kecemburuan Romantis dan Kepuasan Hubungan. 
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6.1 Contoh Kasus dan Data 

ontoh kasus berikut diadopsi oleh penelitian yang dilakukan oleh Ayu Hayati Lubis 

dan Mardianto dengan judul artikel “Hubungan Perilaku Judi Online dengan 

Gangguan Emosi Mahasiswa” di Jurnal In Trend: International Journal of Trends 

in Global Psychological Science and Education pada tahun 2024. Data untuk latihan diberikan 

pada Tabel 6.1. 

Tabel 6.1 Data Latihan 
Responden Perilaku Judi Online Gangguan Emosi 

1 75 78 

2 71 62 

3 78 67 

4 50 60 

5 71 61 

6 75 70 

7 79 66 

8 61 59 

9 80 77 

10 79 80 

11 65 67 

12 85 85 

13 66 56 

14 69 55 

15 81 75 

16 87 71 

17 76 77 

18 70 65 

19 52 60 

20 81 82 

C 

CONTOH KASUS KORELASI PEARSON: 
HUBUNGAN PERILAKU JUDI ONLINE  

DENGAN GANGGUAN EMOSI MAHASISWA 
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Responden Perilaku Judi Online Gangguan Emosi 

21 62 65 

22 74 78 

23 55 60 

24 63 67 

25 78 80 

26 58 58 

27 55 65 

28 70 80 

29 83 73 

30 70 70 

31 59 64 

32 86 78 

33 70 85 

34 50 60 

35 49 60 

36 82 80 

37 79 80 

38 88 87 

39 76 79 

40 70 68 

41 65 70 

42 70 69 

43 45 55 

44 53 63 

45 68 70 

46 82 79 

47 75 80 

48 58 53 

49 70 61 

50 47 50 

51 61 58 

52 67 73 

53 70 81 

54 65 72 

55 52 50 

 Berdasarkan pada data Tabel 6.1, akan digunakan uji korelasi Pearson dan Spearman 

untuk menguji apakah terdapat hubungan atau korelasi yang signifikan antara Perilaku Judi 

Online dengan Gangguan Emosi pada Mahasiswa. 
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6.2 Penyelesaian dengan SPSS  

6.2.1 Input Data ke dalam SPSS 

Data pada Tabel 6.1 diinput ke dalam SPSS seperti pada Gambar 6.1. 

 

Gambar 6.1 Input Data dalam SPSS 

6.2.2 Statistik Deskriptif 

 Data pada Tabel 6.1 akan dihitung nilai minimum, maksimum, rata-rata dan standar 

deviasi. Pilih Analyze => Descriptive Statistics => Descriptives (Gambar 6.2). Pindahkan 

variabel Perilaku Judi Online dengan Gangguan Emosi ke kotak sebelah kanan. Kemudian pilih 

OK. Tabel 6.2 disajikan output dari statistik deskriptif. 
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Gambar 6.2 Menu Descriptives 

Tabel 6.2 Output SPSS untuk Statistik Deskriptif 

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Perilaku Judi Online 55 45.00 88.00 68.6545 11.30424 

Gangguan Emosi 55 50.00 87.00 68.9818 9.74203 

Valid N (listwise) 55     

Berdasarkan Tabel 6.2: 

 Diketahui nilai minimum Perilaku Judi Online adalah 45, sementara nilai maksimum 

Perilaku Judi Online adalah 88. Rata-rata Perilaku Judi Online adalah 68.65, dengan standar 

deviasi 11.30424. 
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 Diketahui nilai minimum Gangguan Emosi adalah 50, sementara nilai maksimum 

Gangguan Emosi adalah 87. Rata-rata Gangguan Emosi adalah 68.98, dengan standar 

deviasi 9.74203. 

6.2.3 Analisis Arah Sebaran Data (Scatterplot) 

 Selanjutnya akan dilihat arah sebaran data antara Perilaku Judi Online dengan Gangguan 

Emosi. Pilih Graphs => Legacy Dialogs => Scatter/Dot (Gambar 6.3). Kemudian pilih Simple 

Scatter. 

  

 

Gambar 6.3 Menu Scatter/Dot 

 Pindahkan variabel Perilaku Judi Online ke dalam kotak X-Axis:, sementara Gangguan 

Emosi pada kotak Y-Axis. Kemudian pilih OK. Gambar 6.4 disajikan tampilan sebaran data 

antara Perilaku Judi Online dengan Gangguan Emosi. Berdasarkan Gambar 6.4 terlihat bahwa 

arah sebaran data cenderung memiliki arah positif. Hal ini juga terlihat dari kemiringan garis, 

dari kiri bawah, ke kanan atas. Dengan kata lain, semakin tinggi Perilaku Judi Online, maka 
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semakin tinggi Gangguan Emosi. Atau sebaliknya, semakin rendah Perilaku Judi Online, maka 

semakin rendah juga Gangguan Emosi. 

 

Gambar 6.4 Sebaran Data antara Perilaku Judi Online dengan Gangguan Emosi 

6.2.4 Korelasi Pearson dan Spearman 

 Selanjutnya pilih Analyze => Correlation => Bivariate (Gambar 6.2). Pindahkan 

variabel Perilaku Judi Online dan Gangguan Emosi ke kotak sebelah kanan. Kemudian ceklis 

menu Pearson dan Spearman. Lalu pilih OK. 

  

Gambar 6.2 Analisis Data dengan SPSS 
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Tabel 6.2 Output Korelasi Pearson dan Spearman  

Correlations 

  Perilaku Judi 

Online Gangguan Emosi 

Perilaku Judi Online Pearson Correlation 1 .774** 

Sig. (2-tailed)  .000 

N 55 55 

Gangguan Emosi Pearson Correlation .774** 1 

Sig. (2-tailed) .000  

N 55 55 

**. Correlation is significant at the 0.01 level (2-tailed). 
 

Correlations 

   Perilaku Judi 

Online Gangguan Emosi 

Spearman's rho Perilaku Judi Online Correlation Coefficient 1.000 .768** 

Sig. (2-tailed) . .000 

N 55 55 

Gangguan Emosi Correlation Coefficient .768** 1.000 

Sig. (2-tailed) .000 . 

N 55 55 

**. Correlation is significant at the 0.01 level (2-tailed). 

Berdasarkan hasil uji korelasi Pearson dan Spearman pada Tabel 6.2: 

 Diketahui nilai korelasi Pearson antara Perilaku Judi Online dan Gangguan Emosi adalah 

0.774, yang berarti, jika Perilaku Judi Online meningkat, maka Gangguan Emosi meningkat 

atau sebaliknya jika Perilaku Judi Online menurun, maka Gangguan Emosi menurun. 

Diketahui nilai Sig. (2-tailed) adalah 0.000 < 0.05, maka disimpulkan terdapat korelasi yang 

signifikan antara Perilaku Judi Online dan Gangguan Emosi. 

 Diketahui nilai korelasi Spearman antara Perilaku Judi Online dan Gangguan Emosi adalah 

0.768, yang berarti, jika Perilaku Judi Online meningkat, maka Gangguan Emosi meningkat 

atau sebaliknya jika Perilaku Judi Online menurun, maka Gangguan Emosi menurun. 

Diketahui nilai Sig. (2-tailed) adalah 0.000 < 0.05, maka disimpulkan terdapat korelasi yang 

signifikan antara Perilaku Judi Online dan Gangguan Emosi. 
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61 APLIKASI METODE STATISTIKA KORELASI PEARSON & SPEARMAN  

Di Artikel Jurnal Nasional Bidang Psikologi Dengan SPSS 

 

 

 

 

 

 

7.1 Contoh Kasus dan Data 

ontoh kasus berikut diadopsi oleh penelitian yang dilakukan oleh Ashilla Astari 

Sukma, Yessy Maynani Nurrochma, Ardelia Putri Hanifah dengan judul artikel 

“Religiusitas dan Resiliensi Akademik Mahasiswa Muslim Yogyakarta” di 

Indonesian Journal of Psychological Studies pada tahun 2024. Data untuk latihan diberikan 

pada Tabel 7.1. 

Tabel 7.1 Data Latihan 
Responden Religiusitas Resiliensi Akademik 

1 85 80 

2 75 78 

3 67 76 

4 65 70 

5 62 52 

6 64 71 

7 83 70 

8 89 88 

9 77 79 

10 55 57 

11 62 58 

12 49 61 

13 50 60 

14 71 79 

15 60 55 

16 49 60 

17 61 80 

18 58 55 

19 70 50 

20 59 62 

C 

CONTOH KASUS KORELASI PEARSON: 
HUBUNGAN RELIGIUSITAS DAN RESILIENSI 

AKADEMIK MAHASISWA MUSLIM 
YOGYAKARTA 
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Responden Religiusitas Resiliensi Akademik 

21 70 59 

22 61 71 

23 59 55 

24 61 76 

25 59 45 

26 62 59 

27 49 65 

28 67 70 

29 55 69 

30 82 60 

 Berdasarkan pada data Tabel 7.1, akan digunakan uji korelasi Pearson dan Spearman 

untuk menguji apakah terdapat hubungan atau korelasi yang signifikan antara Religiusitas dan 

Resiliensi Akademik pada Mahasiswa Muslim Yogyakarta. 

7.2 Penyelesaian dengan SPSS  

7.2.1 Input Data ke dalam SPSS 

Data pada Tabel 7.1 diinput ke dalam SPSS seperti pada Gambar 7.1. 

 

Gambar 7.1 Input Data dalam SPSS 
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7.2.2 Statistik Deskriptif 

 Data pada Tabel 7.1 akan dihitung nilai minimum, maksimum, rata-rata dan standar 

deviasi. Pilih Analyze => Descriptive Statistics => Descriptives (Gambar 7.2). Pindahkan 

variabel Religiusitas dan Resiliensi Akademik ke kotak sebelah kanan. Kemudian pilih OK. 

Tabel 7.2 disajikan output dari statistik deskriptif. 

  

Gambar 7.2 Menu Descriptives 

Tabel 7.2 Output SPSS untuk Statistik Deskriptif 

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Religiusitas 30 49.00 89.00 64.5333 10.78228 

Resiliensi Akademik 30 45.00 88.00 65.6667 10.68461 

Valid N (listwise) 30     

Berdasarkan Tabel 7.2: 

 Diketahui nilai minimum Religiusitas adalah 49, sementara nilai maksimum Religiusitas 

adalah 89. Rata-rata Religiusitas adalah 64.53, dengan standar deviasi 10.78228. 

 Diketahui nilai minimum Resiliensi Akademik adalah 45, sementara nilai maksimum 

Resiliensi Akademik adalah 88. Rata-rata Resiliensi Akademik adalah 65.66, dengan 

standar deviasi 10.68461. 
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7.2.3 Analisis Arah Sebaran Data (Scatterplot) 

 Selanjutnya akan dilihat arah sebaran data antara Religiusitas dan Resiliensi Akademik. 

Pilih Graphs => Legacy Dialogs => Scatter/Dot (Gambar 7.3). Kemudian pilih Simple 

Scatter. 

  

 

Gambar 7.3 Menu Scatter/Dot 

 Pindahkan variabel Religiusitas ke dalam kotak X-Axis:, sementara Resiliensi Akademik 

pada kotak Y-Axis. Kemudian pilih OK. Gambar 7.4 disajikan tampilan sebaran data antara 

Religiusitas dan Resiliensi Akademik. Berdasarkan Gambar 7.4 terlihat bahwa arah sebaran data 

cenderung memiliki arah positif. Hal ini juga terlihat dari kemiringan garis, dari kiri bawah, ke 

kanan atas. Dengan kata lain, semakin tinggi Religiusitas maka semakin tinggi Resiliensi 

Akademik atau sebaliknya, semakin rendah Religiusitas maka semakin rendah Resiliensi 

Akademik. 
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Gambar 7.4 Sebaran Data antara Religiusitas dan Resiliensi Akademik 

7.2.4 Korelasi Pearson dan Spearman 

 Selanjutnya pilih Analyze => Correlation => Bivariate (Gambar 7.2). Pindahkan 

variabel Religiusitas dan Resiliensi Akademik ke kotak sebelah kanan. Kemudian ceklis menu 

Pearson dan Spearman. Lalu pilih OK. 

  

Gambar 7.2 Analisis Data dengan SPSS 
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Tabel 7.2 Output Korelasi Pearson dan Spearman  

Correlations 

  

Religiusitas 

Resiliensi 

Akademik 

Religiusitas Pearson Correlation 1 .508** 

Sig. (2-tailed)  .004 

N 30 30 

Resiliensi Akademik Pearson Correlation .508** 1 

Sig. (2-tailed) .004  

N 30 30 

**. Correlation is significant at the 0.01 level (2-tailed). 
 

Correlations 

   

Religiusitas 

Resiliensi 

Akademik 

Spearman's rho Religiusitas Correlation Coefficient 1.000 .460* 

Sig. (2-tailed) . .011 

N 30 30 

Resiliensi Akademik Correlation Coefficient .460* 1.000 

Sig. (2-tailed) .011 . 

N 30 30 

*. Correlation is significant at the 0.05 level (2-tailed). 

Berdasarkan hasil uji korelasi Pearson dan Spearman pada Tabel 7.2: 

 Diketahui nilai korelasi Pearson antara Religiusitas dan Resiliensi Akademik adalah 0,508, 

yang berarti, jika Religiusitas meningkat, maka Resiliensi Akademik meningkat atau 

sebaliknya jika Religiusitas menurun, maka Resiliensi Akademik menurun. Diketahui nilai 

Sig. (2-tailed) adalah 0,004 < 0,05, maka disimpulkan terdapat korelasi yang signifikan 

antara Religiusitas dan Resiliensi Akademik. 

 Diketahui nilai korelasi Spearman antara Religiusitas dan Resiliensi Akademik adalah 

0,460, yang berarti, jika Religiusitas meningkat, maka Resiliensi Akademik meningkat atau 

sebaliknya jika Religiusitas menurun, maka Resiliensi Akademik menurun. Diketahui nilai 

Sig. (2-tailed) adalah 0,011 < 0,05, maka disimpulkan terdapat korelasi yang signifikan 

antara Religiusitas dan Resiliensi Akademik. 
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8.1 Contoh Kasus dan Data 

ontoh kasus berikut diadopsi oleh penelitian yang dilakukan oleh Suci Rahmanda dan 

Rahayu Hardianti Utami dengan judul artikel “Hubungan Antara Peer Support dan 

Subjective Well-Being pada Mahasiswa Tingkat Akhir Universitas Negeri 

Padang” di In Trend: International Journal of Trends in Global Psychological Science and 

Education pada tahun 2024. Data untuk Latihan diberikan pada Tabel 8.1. 

Tabel 8.1 Data Latihan 
Responden Peer Support Subjective Well-Being 

1 62 72 

2 60 70 

3 56 65 

4 53 55 

5 60 59 

6 80 72 

7 60 65 

8 78 80 

9 65 70 

10 78 82 

11 70 80 

12 77 67 

13 80 70 

14 69 66 

15 78 81 

16 82 70 

17 79 81 

18 55 60 

19 60 59 

20 70 73 

C 

CONTOH KASUS KORELASI PEARSON: 
HUBUNGAN ANTARA PEER SUPPORT  
DAN SUBJECTIVE WELL-BEING PADA 

MAHASISWA TINGKAT AKHIR  
UNIVERSITAS NEGERI PADANG 
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Responden Peer Support Subjective Well-Being 

21 69 70 

22 75 80 

23 88 75 

24 79 85 

25 68 60 

26 69 76 

27 59 61 

28 73 80 

29 85 88 

30 88 82 

31 77 80 

32 59 68 

33 63 60 

34 80 70 

35 72 69 

36 77 80 

37 50 48 

38 63 59 

39 66 58 

40 55 70 

41 70 62 

42 61 59 

43 60 61 

44 74 72 

45 53 61 

 

 Berdasarkan pada data Tabel 8.1, akan digunakan uji korelasi Pearson dan Spearman 

untuk menguji apakah terdapat hubungan atau korelasi yang signifikan antara Peer Support dan 

Subjective Well-Being. 

8.2 Penyelesaian dengan SPSS  

8.2.1 Input Data ke dalam SPSS 

Data pada Tabel 8.1 diinput ke dalam SPSS seperti pada Gambar 8.1. 
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 Gambar 8.1 Input Data dalam SPSS  

8.2.2 Statistik Deskriptif 

 Data pada Tabel 8.1 akan dihitung nilai minimum, maksimum, rata-rata dan standar 

deviasi. Pilih Analyze => Descriptive Statistics => Descriptives (Gambar 8.2). Pindahkan 

variabel Peer Support dan Subjective Well-Being ke kotak sebelah kanan. Kemudian pilih OK. 

Tabel 8.2 disajikan output dari statistik deskriptif. 

  

Gambar 8.2 Menu Descriptives 
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Tabel 8.2 Output SPSS untuk Statistik Deskriptif 

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Peer Support 45 50.00 88.00 69.0000 10.09500 

Subjective Well Being 45 48.00 88.00 69.5778 9.26501 

Valid N (listwise) 45     

Berdasarkan Tabel 8.2: 

 Diketahui nilai minimum Peer Support adalah 50, sementara nilai maksimum Peer Support 

adalah 88. Rata-rata Peer Support adalah 69, dengan standar deviasi 10.09500 

 Diketahui nilai minimum Subjective Well-Being adalah 48, sementara nilai maksimum 

Subjective Well-Being adalah 88. Rata-rata Subjective Well-Being adalah 69.57, dengan 

standar deviasi 9.26501 

8.2.3 Analisis Arah Sebaran Data (Scatterplot) 

 Selanjutnya akan dilihat arah sebaran data antara Peer Support dan Subjective Well-

Being. Pilih Graphs => Legacy Dialogs => Scatter/Dot (Gambar 8.3). Kemudian pilih Simple 

Scatter. 
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Gambar 8.3 Menu Scatter/Dot 

 Pindahkan variabel Peer Support ke dalam kotak X-Axis:, sementara Subjective Well-

Being pada kotak Y-Axis. Kemudian pilih OK. Gambar 8.4 disajikan tampilan sebaran data 

antara Peer Support dan Subjective Well-Being. Berdasarkan Gambar 8.4 terlihat bahwa arah 

sebaran data cenderung memiliki arah positif Hal ini juga terlihat dari kemiringan garis, dari kiri 

bawah, ke kanan atas. Dengan kata lain, semakin tinggi Peer Support, maka semakin tinggi 

Subjective Well-Being. Atau sebaliknya, semakin rendah Peer Support, maka semakin rendah 

juga Subjective Well-Being. 

 

Gambar 8.4 Sebaran Data antara Peer Support dan Subjective Well-Being 
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8.2.4 Korelasi Pearson dan Spearman 

 Selanjutnya pilih Analyze => Correlation => Bivariate (Gambar 8.2). Pindahkan 

variabel Peer Support dan Subjective Well-Being ke kotak sebelah kanan. Kemudian ceklis 

menu Pearson dan Spearman. Lalu pilih OK. 

  

Gambar 8.2 Analisis Data dengan SPSS 

Tabel 8.2 Output Korelasi Pearson dan Spearman  

Correlations 

  

Peer Support 

Subjective Well 

Being 

Peer Support Pearson Correlation 1 .759** 

Sig. (2-tailed)  .000 

N 45 45 

Subjective Well Being Pearson Correlation .759** 1 

Sig. (2-tailed) .000  

N 45 45 

**. Correlation is significant at the 0.01 level (2-tailed). 
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Correlations 

   

Peer Support 

Subjective Well 

Being 

Spearman's rho Peer Support Correlation Coefficient 1.000 .739** 

Sig. (2-tailed) . .000 

N 45 45 

Subjective Well Being Correlation Coefficient .739** 1.000 

Sig. (2-tailed) .000 . 

N 45 45 

**. Correlation is significant at the 0.01 level (2-tailed). 

Berdasarkan hasil uji korelasi Pearson dan Spearman pada Tabel 8.2: 

 Diketahui nilai korelasi Pearson antara Peer Support dan Subjective Well-Being adalah 

0.759, yang berarti, jika Peer Support meningkat, maka Subjective Well-Being meningkat 

atau sebaliknya jika Peer Support menurun, maka Subjective Well-Being menurun. 

Diketahui nilai Sig. (2-tailed) adalah 0.000 < 0.05, maka disimpulkan terdapat korelasi yang 

signifikan antara Peer Support dan Subjective Well-Being. 

 Diketahui nilai korelasi Spearman antara Religiusitas dan Resiliensi Akademik adalah 

0.739, yang berarti, jika Peer Support meningkat, maka Subjective Well-Being meningkat 

atau sebaliknya jika Peer Support menurun, maka Subjective Well-Being menurun. 

Diketahui nilai Sig. (2-tailed) adalah 0.000 < 0.05, maka disimpulkan terdapat korelasi yang 

signifikan antara Peer Support dan Subjective Well-Being. 
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9.1 Contoh Kasus dan Data 

ontoh kasus berikut diadopsi oleh penelitian yang dilakukan oleh Ulya Layyina, 

Zaujatul Amna, Syarifah Faradina, dan Dahlia Dahlia dengan judul artikel 

“Mindfulness dan Penerimaan Diri: Studi Pada Ibu Yang Memiliki Anak 

Cerebral Palsy” di Seurune : Jurnal Psikologi Unsyiah pada tahun 2024. Data untuk Latihan 

diberikan pada Tabel 9.1. 

Tabel 9.1 Data Latihan 
Responden Mindfulness Penerimaan Diri 

1 70 73 

2 69 70 

3 75 80 

4 88 75 

5 79 85 

6 68 60 

7 69 76 

8 59 61 

9 73 80 

10 85 88 

11 55 65 

12 55 70 

13 70 50 

14 85 79 

15 66 76 

16 60 60 

17 72 60 

18 88 77 

19 81 69 

C 

CONTOH KASUS KORELASI PEARSON: 
HUBUNGAN ANTARA MINDFULNESS DAN 

PENERIMAAN DIRI : STUDI PADA IBU YANG 
MEMILIKI ANAK CEREBRAL PALSY 
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Responden Mindfulness Penerimaan Diri 

20 52 62 

21 60 81 

22 65 75 

23 70 59 

24 63 79 

25 66 58 

26 62 74 

27 50 49 

28 67 77 

29 50 68 

30 71 72 

31 66 51 

32 83 70 

33 61 79 

34 48 50 

35 68 51 

 Berdasarkan pada data Tabel 9.1, akan digunakan uji korelasi Pearson dan Spearman 

untuk menguji apakah terdapat hubungan atau korelasi yang signifikan antara Mindfulness dan 

Penerimaan Diri. 

9.2 Penyelesaian dengan SPSS  

9.2.1 Input Data ke dalam SPSS 

Data pada Tabel 9.1 diinput ke dalam SPSS seperti pada Gambar 9.1. 

9.2.2 Statistik Deskriptif 

 Data pada Tabel 9.1 akan dihitung nilai minimum, maksimum, rata-rata dan standar 

deviasi. Pilih Analyze => Descriptive Statistics => Descriptives (Gambar 9.2). Pindahkan 

variabel Mindfulness dan Penerimaan Diri ke kotak sebelah kanan. Kemudian pilih OK. Tabel 

9.2 disajikan output dari statistik deskriptif. 
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Gambar 9.1 Input Data dalam SPSS 

 

Gambar 9.2 Menu Descriptives 
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Tabel 9.2 Output SPSS untuk Statistik Deskriptif 

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Mindfulness 35 48.00 88.00 67.6857 10.82690 

Penerimaan Diri 35 49.00 88.00 68.8286 10.86951 

Valid N (listwise) 35     

Berdasarkan Tabel 9.2: 

 Diketahui nilai minimum Mindfulness adalah 48, sementara nilai maksimum Mindfulness 

adalah 88. Rata-rata Mindfulness adalah 67.68, dengan standar deviasi 10.82690. 

 Diketahui nilai minimum Penerimaan Diri adalah 49, sementara nilai maksimum 

Penerimaan Diri adalah 88. Rata-rata Penerimaan Diri adalah 68.82, dengan standar deviasi 

10.86951 

9.2.3 Analisis Arah Sebaran Data (Scatterplot) 

 Selanjutnya akan dilihat arah sebaran data antara Mindfulness dan Penerimaan Diri. Pilih 

Graphs => Legacy Dialogs => Scatter/Dot (Gambar 9.3). Kemudian pilih Simple Scatter. 
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Gambar 9.3 Menu Scatter/Dot 

 Pindahkan variabel Mindfulness ke dalam kotak X-Axis:, sementara Penerimaan Diri 

pada kotak Y-Axis. Kemudian pilih OK. Gambar 9.4 disajikan tampilan sebaran data antara 

Mindfulness dan Penerimaan Diri. Berdasarkan Gambar 9.4 terlihat bahwa arah sebaran data 

cenderung memiliki arah positif Hal ini juga terlihat dari kemiringan garis, dari kiri bawah, ke 

kanan atas. Dengan kata lain, semakin tinggi Mindfulness, maka semakin tinggi Penerimaan 

Diri. Atau sebaliknya, semakin rendah Mindfulness, maka semakin rendah Penerimaan Diri. 

 

Gambar 9.4 Sebaran Data antara Mindfulness dan Penerimaan Diri 
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9.2.4 Korelasi Pearson dan Spearman 

 Selanjutnya pilih Analyze => Correlation => Bivariate (Gambar 9.2). Pindahkan 

variabel Mindfulness dan Penerimaan Diri ke kotak sebelah kanan. Kemudian ceklis menu 

Pearson dan Spearman. Lalu pilih OK. 

 

 

Gambar 9.2 Analisis Data dengan SPSS 

Tabel 9.2 Output Korelasi Pearson dan Spearman  

Correlations 

  Mindfulness Penerimaan Diri 

Mindfulness Pearson Correlation 1 .462** 

Sig. (2-tailed)  .005 

N 35 35 

Penerimaan Diri Pearson Correlation .462** 1 

Sig. (2-tailed) .005  

N 35 35 

**. Correlation is significant at the 0.01 level (2-tailed). 
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Correlations 

   Mindfulness Penerimaan Diri 

Spearman's rho Mindfulness Correlation Coefficient 1.000 .404* 

Sig. (2-tailed) . .016 

N 35 35 

Penerimaan Diri Correlation Coefficient .404* 1.000 

Sig. (2-tailed) .016 . 

N 35 35 

*. Correlation is significant at the 0.05 level (2-tailed). 

Berdasarkan hasil uji korelasi Pearson dan Spearman pada Tabel 9.2: 

 Diketahui nilai korelasi Pearson antara Mindfulness dan Penerimaan Diri adalah 0.462, yang 

berarti, jika Mindfulness meningkat, maka Penerimaan Diri meningkat atau sebaliknya jika 

Mindfulness menurun, maka Penerimaan Diri menurun. Diketahui nilai Sig. (2-tailed) 

adalah 0.005 < 0,05, maka disimpulkan terdapat korelasi yang signifikan antara Peer 

Support dan Subjective Well-Being. 

 Diketahui nilai korelasi Spearman antara Mindfulness dan Penerimaan Diri adalah 0.404, 

yang berarti, jika Mindfulness meningkat, maka Penerimaan Diri meningkat atau sebaliknya 

jika Mindfulness menurun, maka Penerimaan Diri menurun. Diketahui nilai Sig. (2-tailed) 

adalah 0.016 < 0.05, maka disimpulkan terdapat korelasi yang signifikan antara Mindfulness 

dan Penerimaan Diri. 
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10.1 Contoh Kasus dan Data 

ontoh kasus berikut diadopsi oleh penelitian yang dilakukan oleh Reski Natalia Biring 

dan Doddy Hendro Wibowo dengan judul artikel “Self-Compassion dengan 

Loneliness Pada Remaja Akhir yang Sedang Merantau” di Jurnal Psikoborneo 

Jurnal Imiah Psikologi pada tahun 2024. Data untuk Latihan diberikan pada Tabel 10.1. 

Tabel 10.1 Data Latihan 
Responden Self-Compassion Loneliness 

1 60 88 

2 70 50 

3 75 55 

4 49 75 

5 62 79 

6 60 85 

7 75 46 

8 57 75 

9 47 85 

10 86 52 

11 49 60 

12 51 70 

13 70 45 

14 82 71 

15 48 70 

16 51 79 

17 80 55 

18 62 81 

19 55 70 

20 60 60 

21 41 88 

C 

CONTOH KASUS KORELASI PEARSON: 
HUBUNGAN SELF-COMPASSION DENGAN 
LONELINESS PADA REMAJA AKHIR YANG 

SEDANG MERANTAU 
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Responden Self-Compassion Loneliness 

22 76 85 

23 74 50 

24 67 81 

25 64 44 

26 80 52 

27 79 42 

28 81 65 

29 52 78 

30 50 77 

31 66 48 

32 70 50 

33 61 80 

34 53 68 

35 65 50 

36 52 72 

37 68 41 

38 76 50 

39 83 56 

40 57 88 

 Berdasarkan pada data Tabel 10.1, akan digunakan uji korelasi Pearson dan Spearman 

untuk menguji apakah terdapat hubungan atau korelasi yang signifikan antara Self-Compassion 

dan Loneliness. 

10.2 Penyelesaian dengan SPSS  

10.2.1 Input Data ke dalam SPSS 

Data pada Tabel 10.1 diinput ke dalam SPSS seperti pada Gambar 10.1. 

10.2.2 Statistik Deskriptif 

 Data pada Tabel 10.1 akan dihitung nilai minimum, maksimum, rata-rata dan standar 

deviasi. Pilih Analyze => Descriptive Statistics => Descriptives (Gambar 10.2). Pindahkan 

variabel Self-Compassion dan Loneliness ke kotak sebelah kanan. Kemudian pilih OK. Tabel 

10.2 disajikan output dari statistik deskriptif. 
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Gambar 10.1 Input Data dalam SPSS 

 

Gambar 10.2 Menu Descriptives 
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Tabel 10.2 Output SPSS untuk Statistik Deskriptif 

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Self Compassion 40 41.00 86.00 64.1000 12.06138 

Loneliness 40 41.00 88.00 65.4000 15.17555 

Valid N (listwise) 40     

Berdasarkan Tabel 10.2: 

 Diketahui nilai minimum Self-Compassion adalah 41, sementara nilai maksimum Self-

Compassion adalah 86. Rata-rata Self-Compassion adalah 64.1, dengan standar deviasi 

12.06138 

 Diketahui nilai minimum Loneliness adalah 45, sementara nilai maksimum Loneliness 

adalah 88. Rata-rata Loneliness adalah 65.4, dengan standar deviasi 15.17555 

10.2.3 Analisis Arah Sebaran Data (Scatterplot) 

 Selanjutnya akan dilihat arah sebaran data antara Self-Compassion dan Loneliness. Pilih 

Graphs => Legacy Dialogs => Scatter/Dot (Gambar 10.3). Kemudian pilih Simple Scatter. 

  

 

Gambar 10.3 Menu Scatter/Dot 
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 Pindahkan variabel Self-Compassion ke dalam kotak X-Axis:, sementara Loneliness 

pada kotak Y-Axis. Kemudian pilih OK. Gambar 10.4 disajikan tampilan sebaran data antara 

Self-Compassion dan Loneliness. Berdasarkan Gambar 10.4 terlihat bahwa arah sebaran data 

cenderung memiliki arah negatif. Hal ini juga terlihat dari kemiringan garis, dari kiri atas, ke 

kanan bawah. Dengan kata lain, semakin tinggi Self-Compassion, maka semakin rendah 

Loneliness. Atau sebaliknya, semakin rendah Self-Compassion, maka semakin tinggi Loneliness. 

 

Gambar 10.4 Sebaran Data antara Self-Compassion dan Loneliness 

10.2.4 Korelasi Pearson dan Spearman 

 Selanjutnya pilih Analyze => Correlation => Bivariate (Gambar 10.2). Pindahkan 

variabel Self-Compassion dan Loneliness ke kotak sebelah kanan. Kemudian ceklis menu 

Pearson dan Spearman. Lalu pilih OK. 

 

Gambar 10.2 Analisis Data dengan SPSS 
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Tabel 10.2 Output Korelasi Pearson dan Spearman  

Correlations 

  Self Compassion Loneliness 

Self Compassion Pearson Correlation 1 -.576** 

Sig. (2-tailed)  .000 

N 40 40 

Loneliness Pearson Correlation -.576** 1 

Sig. (2-tailed) .000  

N 40 40 

**. Correlation is significant at the 0.01 level (2-tailed). 
 

Correlations 

   Self Compassion Loneliness 

Spearman's rho Self Compassion Correlation Coefficient 1.000 -.523** 

Sig. (2-tailed) . .001 

N 40 40 

Loneliness Correlation Coefficient -.523** 1.000 

Sig. (2-tailed) .001 . 

N 40 40 

**. Correlation is significant at the 0.01 level (2-tailed). 

Berdasarkan hasil uji korelasi Pearson dan Spearman pada Tabel 10.2: 

 Diketahui nilai korelasi Pearson antara Self-Compassion dan Loneliness adalah -0.576, yang 

berarti, jika Self-Compassion meningkat, maka Loneliness menurun atau sebaliknya jika 

Self-Compassion menurun, maka Loneliness meningkat. Diketahui nilai Sig. (2-tailed) 

adalah 0.000 < 0.05, maka disimpulkan terdapat korelasi yang signifikan antara Self-

Compassion dan Loneliness. 

 Diketahui nilai korelasi Spearman antara Self-Compassion dan Loneliness adalah -0.532, 

yang berarti jika Self-Compassion meningkat, maka Loneliness menurun atau sebaliknya 

jika Self-Compassion menurun, maka Loneliness meningkat. Diketahui nilai Sig. (2-tailed) 

adalah 0.001 < 0.05, maka disimpulkan terdapat korelasi yang signifikan antara Self-

Compassion dan Loneliness. 
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11.1  Contoh Kasus dan Data 

ontoh kasus berikut diadopsi oleh penelitian yang dilakukan oleh Ita Djuita, Dinda 

Dwarawati dengan judul artikel “Hubungan Work Engagement terhadap Turnover 

Intention pada Karyawan PT” di Conference Series: Psychology Science pada 

tahun 2024. Data untuk Latihan diberikan pada Tabel 11.1. 

Tabel 11.1 Data Latihan 
Responden Work Engagement Turnover Intention 

1 55 68 

2 58 70 

3 63 85 

4 76 53 

5 50 74 

6 61 83 

7 55 72 

8 60 74 

9 50 77 

10 69 50 

11 60 88 

12 52 75 

13 65 55 

14 48 70 

15 59 60 

16 81 55 

17 76 61 

18 79 79 

19 50 79 

20 62 82 

21 45 54 

C 

CONTOH KASUS KORELASI PEARSON: 
HUBUNGAN WORK ENGAGEMENT  

TERHADAP TURNOVER INTENTION 
PADA KARYAWAN PT X 
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Responden Work Engagement Turnover Intention 

22 41 80 

23 88 48 

24 50 78 

25 72 52 

26 52 70 

27 49 82 

28 84 55 

29 53 77 

30 48 87 

31 53 78 

32 81 52 

33 73 53 

34 50 72 

35 56 49 

36 50 82 

37 78 50 

38 55 60 

39 87 55 

40 60 71 

41 75 50 

42 82 66 

43 60 76 

44 81 49 

45 75 51 

46 62 84 

47 55 79 

48 48 63 

49 76 50 

50 50 82 

 Berdasarkan pada data Tabel 11.1, akan digunakan uji korelasi Pearson dan Spearman 

untuk menguji apakah terdapat hubungan atau korelasi yang signifikan antara Work Engagement 

dan Turnover Intention.  

11.2 Penyelesaian dengan SPSS  

11.2.1 Input Data ke dalam SPSS 

Data pada Tabel 11.1 diinput ke dalam SPSS seperti pada Gambar 11.1. 
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Gambar 11.1 Input Data dalam SPSS 

11.2.2 Statistik Deskriptif 

 Data pada Tabel 11.1 akan dihitung nilai minimum, maksimum, rata-rata dan standar 

deviasi. Pilih Analyze => Descriptive Statistics => Descriptives (Gambar 11.2). Pindahkan 

variabel Work Engagement dan Turnover Intention ke kotak sebelah kanan. Kemudian pilih 

OK. Tabel 10.2 disajikan output dari statistik deskriptif. 

 

Gambar 11.2 Menu Descriptives 
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Tabel 11.2 Output SPSS untuk Statistik Deskriptif 

Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Work Engagement 50 41.00 88.00 62.3600 12.89164 

Turnover Intention 50 48.00 88.00 67.3000 12.89241 

Valid N (listwise) 50     

Berdasarkan Tabel 11.2: 

 Diketahui nilai minimum Work Engagement adalah 41, sementara nilai maksimum Work 

Engagement adalah 88. Rata-rata Kontrol Diri adalah 62.36, dengan standar deviasi 

12.89164 

 Diketahui nilai minimum dan Turnover Intention adalah 48, sementara nilai maksimum 

Kencanduan Gadget adalah 88. Rata-rata dan Turnover Intention adalah 67.3, dengan 

standar deviasi 12.89241 

11.2.3 Analisis Arah Sebaran Data (Scatterplot) 

 Selanjutnya akan dilihat arah sebaran data antara Work Engagement dan Turnover 

Intention. Pilih Graphs => Legacy Dialogs => Scatter/Dot (Gambar 11.3). Kemudian pilih 

Simple Scatter. 

 Pindahkan variabel Work Engagement ke dalam kotak X-Axis:, sementara Turnover 

Intention pada kotak Y-Axis. Kemudian pilih OK. Gambar 11.4 disajikan tampilan sebaran data 

antara Work Engagement dan Turnover Intention. Berdasarkan Gambar 11.4 terlihat bahwa arah 

sebaran data cenderung memiliki arah negatif. Hal ini juga terlihat dari kemiringan garis, dari 

kiri atas, ke kanan bawah. Dengan kata lain, semakin tinggi Work Engagement, maka semakin 

rendah Turnover Intention. Atau sebaliknya, semakin rendah Work Engagement maka semakin 

tinggi Turnover Intention. 
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Gambar 11.3 Menu Scatter/Dot 

 

Gambar 11.4 Sebaran Data antara Work Engagement dan Turnover Intention 

11.2.4 Korelasi Pearson dan Spearman 

 Selanjutnya pilih Analyze => Correlation => Bivariate (Gambar 11.2). Pindahkan 

variabel Work Engagement dan Turnover Intention ke kotak sebelah kanan. Kemudian ceklis 

menu Pearson dan Spearman. Lalu pilih OK. 
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Gambar 11.2 Analisis Data dengan SPSS 

Tabel 11.2 Output Korelasi Pearson dan Spearman  

Correlations 

  Work 

Engagement 

Turnover 

Intention 

Work Engagement Pearson Correlation 1 -.634** 

Sig. (2-tailed)  .000 

N 50 50 

Turnover Intention Pearson Correlation -.634** 1 

Sig. (2-tailed) .000  

N 50 50 

**. Correlation is significant at the 0.01 level (2-tailed). 
 

Correlations 

   Work 

Engagement 

Turnover 

Intention 

Spearman's rho Work Engagement Correlation Coefficient 1.000 -.533** 

Sig. (2-tailed) . .000 

N 50 50 
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Turnover Intention Correlation Coefficient -.533** 1.000 

Sig. (2-tailed) .000 . 

N 50 50 

**. Correlation is significant at the 0.01 level (2-tailed). 

Berdasarkan hasil uji korelasi Pearson dan Spearman pada Tabel 11.2: 

 Diketahui nilai korelasi Pearson antara Work Engagement dan Turnover Intention adalah -

0.634, yang berarti, jika Work Engagement meningkat, maka Turnover Intention menurun 

atau sebaliknya jika Work Engagement menurun, maka Turnover Intention meningkat. 

Diketahui nilai Sig. (2-tailed) adalah 0.000 < 0.05, maka disimpulkan terdapat korelasi yang 

signifikan antara Work Engagement dan Turnover Intention. 

 Diketahui nilai korelasi Spearman antara Work Engagement dan Turnover Intention adalah -

0.533, yang berarti, jika Work Engagement meningkat, maka Turnover Intention menurun 

atau sebaliknya jika Work Engagement menurun, maka Turnover Intention meningkat. 

Diketahui nilai Sig. (2-tailed) adalah 0.000 < 0.05, maka disimpulkan terdapat korelasi yang 

signifikan antara Work Engagement dan Turnover Intention. 
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